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1 Introduction 
 

To serve the wide variety of management and deployment needs of different organizations, Nitro PDF 
Pro has many installation options.  This guide details those options as well as how to accommodate 
other scenarios such as advanced integrations or installing to non-standard environments.   
 
The Nitro MSI deployment package is designed for enterprise environments where applications are 
deployed business- wide. To better suit a large user base, and to better conform with typical internal 
security policies and user rights, some front-end options have been disabled. 

 
The following guide explains best practices and requirements in relation to various deployment 
methods. These settings can be applied in a number of different ways to suit individual customers’ 
requirements and preferences. 

 
Please note that Nitro PDF Pro is also available as an executable (.exe) installer. This file is provided for 
single-user retail customers and is not covered by the instructions below. All methods described in this 
document apply only to the MSI (.msi) deployment package. 

 
If you require any further assistance, please refer to the Nitro Knowledge Base or Support Forum or 
contact Nitro Customer Support (see Section 7).  

 

2 Installation prerequisites 
 

2.1 System requirements 

Desktops: Windows 10 and 8 (64 bit) 
Servers: Microsoft Windows Server 2008 R2, 2012, 2012 R2 (64 bit), 2016 
Processor: 1.5 GHz or faster 
RAM: 1GB 
Available hard disk space: 4.5GB 
Display screen resolution: 1024x768 
Microsoft Office integrated features: MS Office 2013 (32bit or 64bit), MS Office 2016 (32bit or 
64bit), Microsoft Office 2019 (32bit or 64bit) 
Video hardware acceleration (optional) 
To support iManage integration: 
• server: iManage 10.2 and newer (cloud or on-premises) 
• client: iManage Work Desktop for Windows 10.5 and newer 

 
2.2 Installation Files (Business vs Enterprise vs. Nitro Licensing System) 
 

Nitro PDF Pro uses three different licensing methods—Business, Enterprise, and the Nitro Licensing 
System (NLS)—which correlate with the type of license purchased. 
 

Please ensure you are using the correct MSI package based on your license type. 
 

All three MSI packages contain the same version of Nitro PDF Pro and provide the same features, but 
the licensing system differs based on your license type. The three types of MSI packages are difficult 
to distinguish before being installed so caution is recommended.  The best way to determine your 
license type is to review the product details email sent to you by Nitro after starting your 
subscription.  This email includes both your license code as well as links to the appropriate MSI.  For 
further reference, please review table below outlining the differences: 
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License 
Type 

License Code 
Format 

Installer Link 

Business An 18 digit 
numeric code 
within the email 

http://www.gonitro.com//installers/business/v13/msi/download 
 

Enterprise A .lic file 
attached to the 
email with a 32 
digit name 

http://www.gonitro.com/en/installers/enterprise/v13/msi/download   

NLS No license 
code.  Admins 
manage user 
licenses within 
Nitro Admin 

https://www.gonitro.com/installers/nls/v13/msi/download  

 

 
 

PLEASE NOTE: Using the wrong license/deployment package combination will result in a failed 
activation of Nitro PDF Pro, and the application will need to be reinstalled using the correct 
deployment package. 
 

2.3 Deployment Utility 
 

The Deployment Utility is a visual configuration tool that makes it easy to create an MST file that applies 
your custom configurations to your Nitro PDF Pro deployment. It provides one of the methods of 
customizing MSI properties described in Section 4. 

 

The utility will allow customization for the Business, Enterprise and NLS deployment packages and is 
available on the same download pages as Nitro PDF Pro.  Please note that it is recommended to have the 
same version of the Deployment Tool as Nitro PDF Pro.   
 

3 Installation 

Nitro PDF Pro can be installed using one of two methods: 

1. Starting the MSI file and completing the installation wizard 

2. Using the command line or a script to run the msiexec command. 

3. Deploying via a software package, e.g. Microsoft System Center Configuration Manager 
(SCCM), usually utilises one of the above methods. 

 

NOTE: Certain deployment methods have special requirements. Please refer to the following sections in 
this chapter for more information. Failure to fulfil the requirements detailed may result in a non- 
working deployment of Nitro PDF Pro. 

 
3.1 License activation  

Nitro PDF Pro with Business or Enterprise licenses must be activated using one of the methods listed below.  

Nitro PDF Pro with NLS does not need activation, but users do need to log in prior to using the full feature set 

of Nitro PDF Pro.  Business or Enterprise Licenses can be activated with one of these methods: 

http://www.gonitro.com/installers/business/v13/msi/download
http://www.gonitro.com/installers/business/v13/msi/download
http://www.gonitro.com/en/installers/enterprise/v13/msi/download
https://www.gonitro.com/installers/nls/v13/msi/download
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1. During deployment, provide an MST file that contains the license 

2. After installation through the Nitro PDF Pro user interface 

3. After installation using the ActivateSN.exe tool, either scripted or via command prompt 
(Enterprise license only). The license file can be opened with Notepad to extract the data.  
 

 
3.1.1 During deployment using an MST file (Business and Enterprise licenses) 
 

There are several methods to adjust MSI properties during the installation, see Chapter 4: 
Customizing MSI Properties for more information. 

EXAMPLE: using the Enterprise Deployment Utility to create an MST file containing the license 

1) Open the Enterprise Deployment Utility (Nitro_EnterpriseDeployment.exe)  

2) Click “Browse” and open the Nitro PDF Pro .msi file

 
 

3) Switch to the “Serial Number” section and add your Business or Enterprise license 
 

4) Click “Generate MST File”. The file will be saved in the same locations as the MSI file opened 
in step 1. 

5) Nitro PDF Pro can now be installed by using the MSI and the MST file, e.g. by running 
the following command in CMD window: 

Msiexec -i <path to MSI file> TRANSFORMS=<path to MST file> 

 
3.1.2 After Installation, using the Nitro PDF Pro User Interface (Business and Enterprise licenses) 
 

Once Nitro PDF Pro is installed, go to the Help tab, and click on the “Activate” button. You will be presented 
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with a popup window prompting for license information. 
 

 
 
 

If the window asks for first name, last name, and a serial number, it expects an Enterprise license to be 
entered. If you have a Business license, you need to reinstall Nitro PDF Pro using the correct installation 
file (see Chapter 2.2: Business vs Enterprise vs. NLS licensing). 

 
 

 
 

If the window asks for a serial number only, it expects a Business license to be entered (again, reinstall if 
this is the wrong type of license for you). 

 

 
 

 
After activation, the “Activate” button disappears from the user interface. You can click on “About Nitro 
PDF Pro” to deactivate, if necessary. 

 
3.1.3 After installation, using the ActivateSN.exe Tool (Enterprise Licenses) 
 

This tool is installed with Nitro PDF Pro in the same install location (usually C:\Program Files\...), but 
only for Enterprise licenses. It can be called via a script or a command line, using the following syntax: 
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“C:\Program Files\Nitro\Pro\13\ActivateSN.exe” –s <INSERT-SERIAL- NUMBER-HERE> 
 

It is also possible to disable encryption of the license, which is required by certain deployment methods 
as described in the following sections. Example: 

 

“C:\Program Files\Nitro\Pro\13\ActivateSN.exe” -e false -s <INSERT- SERIAL-NUMBER-HERE> 

 

3.2 Standard deployment on PC/Laptop 
 

Nitro PDF Pro can be installed on a Windows-based computer that meets the prerequisites by simply 
starting the MSI installation file with a double-click. Using that method, some customizations are 
possible, see below. 

 

 
 
 

Set Nitro PDF Pro as the default handler for PDF files 
When checked, the installation process will set Nitro PDF Pro as your default PDF application. 
When unchecked, it will leave the application that is currently set as the default PDF application 
on your computer. 

 

NOTE: Due to a change in the behaviour of Windows 8 and later, this option is not possible for 
those operating systems. The default application must be set manually after installation, or 
automatically following one of the methods described in Chapter 6. 

 

Install Nitro PDF Pro Plugin for Internet Explorer 
When checked this will install the Nitro PDF Pro add-in that allows the opening of PDF files from 
webpages within the Internet browser. It will also set the Nitro add-in as default, meaning that if other 
PDF add-ins have been installed previously, they will no longer be used to open PDF files in the browser. 
If you prefer to use your existing add-ins, leave this box unchecked. 

 
Install Nitro toolbar for Word, Excel, PowerPoint, and Outlook 
When checked, this will install and activate the Nitro PDF Pro MS Office plugin, which adds the Nitro 
PDF Pro ribbon to the user interface of the listed applications. It will not deactivate or overwrite any 
other Office add-ins you may be using. 
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NOTE: If you require any additional customisation of the installation procedure or application 
settings, please refer to Chapter 4: Customising MSI Properties. 
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3.3 Microsoft SCCM and other Deployment Solutions 
 

If you use Microsoft SCCM (or a similar solution) to deploy MSI-based application packages, you can use 
it to deploy Nitro PDF Pro like any other application in your environment. Command line switches, or an 
MST (transform) file, can be used to customize the installation. Please see Chapter 4: Customizing MSI 
Properties for more information. 

 
 

3.4 Virtual Desktop Infrastructures (VDI) 
 

Nitro PDF Pro is fully supported for deployment on VDI infrastructures, such as Citrix XenDesktop or 
VMWare Horizon. Installation can be performed similarly to any other MSI-based application in your 
environment, with the following considerations: 

 

1) All deployments to virtual machines (i.e. where Nitro PDF Pro is installed and running on 
virtual hardware and/or virtualized operating systems) require an Enterprise or NLS license. 
Please refer to Chapter 2.2: Enterprise vs Business vs. NLS Licensing. 

 
2) Where a “master image” is being used to deploy to multiple identical hosts, encryption of the 

license key needs to be disabled when installing Nitro PDF Pro on the master image. This can 
be done using the methods described in Chapter 4: Customizing MSI Properties. If you are 
using the NLS Licensing option, this step not needed. 

 

Example: use the Enterprise Deployment Utility to create an MST file with the following settings: 
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NOTE: The license is encrypted by default. If the license key in use needs to be replaced after installation, the 
method using the ActivateSN.exe as described in Chapter 3.1: License Activation needs to be followed. Using the 
Nitro PDF Pro UI to change the license key will encrypt it. 

 
3.5 Hosted Desktop / Hosted Application 
 

Nitro PDF Pro is fully supported for deployment on hosted desktop or hosted application environments, 
such as Citrix XenApp or Microsoft Remote Desktop Services. Installation can be performed similarly to 
any other MSI-based application in your environment, with the following considerations: 

 
1) All deployments to virtual machines (i.e. where Nitro PDF Pro is installed and running on 

virtual hardware and/or virtualized operating systems) require an Enterprise or NLS license. 
Please refer to Chapter 2.2: Enterprise vs Business vs NLS Licensing. 

 
2) If an Enterprise license is used, access to Nitro PDF Pro must be controlled by e.g. using an 

Active Directory GPO, AppLocker, or the published application settings in the Citrix admin 
console. Failure to do so may result in accidental overuse of the license. 

3) For Business licensing, a “server license” is required, which has two constraints: number of 
activations (A) and number of users per server (B). Number of activations limits the number of 
servers on which Nitro PDF Pro can be installed. Number of users limits the number of 
simultaneous instances of Nitro PDF Pro that can be run on a single server. Once (B) has been 
reached, any subsequent users connecting to the same server will not be able to launch Nitro 
PDF Pro. If Nitro PDF Pro is registered as the default PDF viewer for that user, this may lead to 
issues unless you provide an alternative. The product of (A) x (B) equals the total number of 
licenses purchased, which must be at or below the total number of Nitro users in the 
environment. 

 
NOTE FOR ALL POINTS ABOVE: Nitro does not offer concurrent user licensing at this time. The number of 
licenses purchased must equal or exceed the total number of Nitro users in the environment, even if the 
number of concurrent users at any given time is lower than that. 

 
4) Installation should be completed using Install Application on Terminal Server, found under the 

Control Panel. See the Microsoft best practices article: http://technet.microsoft.com/en- 
us/library/cc742815(WS.10).aspx 

 

5) If you choose to install the Nitro PDF Pro add-ins for Microsoft Office or Internet Explorer, 
please note that the add-ins will be installed for all users. However, the load behavior of the 
add-ins can be controlled on a per user or per group basis using AD GPOs – see Chapter 7: 
Special Configurations. 

 

 

3.6 Microsoft App-V 
 

Nitro PDF Pro can be deployed using App-V; however, there are several considerations. Please ensure 
you understand the points below to achieve a successful outcome. 

 
1) Deployment via App-V requires an Enterprise or NLS License. Please refer to Chapter 2.2: 

Enterprise vs Business vs NLS Licensing. 
 

2) Encryption of the license key needs to be disabled when sequencing the App-V package. This 
can be done using the methods described in Chapter 4: Customizing MSI Properties (see 
example below). 

http://technet.microsoft.com/en-us/library/cc742815(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc742815(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc742815(WS.10).aspx
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3) It is recommended to use Nitro PDF Pro 12.0.0 or later, and App-V versions 5.1 or later. 

4) The Nitro PDF Pro add-ins for Microsoft Office and Internet Explorer are not supported 
in an application streaming deployment. 

 
5) The Nitro PDF Creator (printer) cannot be streamed via App-V and must be excluded from the 

App-V package. However, this tool is necessary for creating PDF files and converting other file 
formats to PDF, and it must be installed separately on all target devices, as per instructions 
below. Please contact Nitro Support to obtain the standalone printer installation file. 

 

Example: Creating an MST file using the Deployment Utility 

1) Open the Enterprise Deployment Utility (Nitro_EnterpriseDeployment.exe) 

2) Click “Browse” and open the Nitro PDF Pro .msi file 

3) On the “General” tab, disable the following settings: 

a. Install toolbars for Microsoft Word, Excel, PowerPoint 

b. Install printer driver 
 

 
 

4) On the “Default Applications & Add-Ons” tab, disable the following setting: 

a. Install Nitro PDF Pro SharePoint and PDF Viewer IE add-ons 
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5) On the “Serial Number” tab (not needed for NLS License) 

a. Click “Load From File” and import your Enterprise license from the .lic file 

b. Uncheck the “Encrypt” setting 
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6) Tick the box to agree to Terms of Service and click “Generate MST File. The file will be saved in the 

same location as the MSI file opened at step 2. 

 
Sequencing Nitro PDF Pro in App-V 

1) Start the Sequencing Wizard, select File / New Package. For more information, please refer to 

https://technet.microsoft.com/en-us/library/cc817128.aspx 

2) Install Nitro PDF Pro with the transform file (MST file) 

a. Open command prompt as administrator and start the installation using the msiexec 
command 
Example: 

    msiexec /i “C:\nitro _xxxx.msi” TRANSFORMS=”C:\nitro_xxxx.mst” 

3) On the Launch Application page, start the application and click Launch (this step is optional) 

4) On the Sequence Package page, click Finish 

 
Install the standalone driver on the target device master image 

1) Install the Creator to any folder except "Program Files" or "Program Files (x86)" 

2) Use the “INSTALLLOCATION” PROPERTY to specify the folder path: 

3) Open command prompt as an Administrator 

4) Run the following command: 

msiexec /i Nitro_Creator_x64.msi INSTALLLOCATION="c:\Nitro\Creator" 

5) Reboot 

 
3.7 Citrix Provisioning Services / Machine Creation Services 
 

Nitro PDF Pro is fully supported on devices with streamed operating systems using Citrix PVS or MCS. 
The following considerations must be met for successful deployment: 

1) All deployments to streamed operating systems require an Enterprise or NLS license. Please 
refer to 
Chapter 2.2: Enterprise vs Business vs NLS Licensing. 

2) Encryption of the license key needs to be disabled when deploying Nitro PDF Pro. This 
can be done using the methods described in Chapter 4: Customizing MSI Properties 

 

3) If, in addition to PVS/MCS, other technologies such as e.g. XenApp or App-V are 
used to provide access to Nitro PDF Pro for users, please refer to the relevant 
sections of this guide for additional requirements. 

 

  

https://technet.microsoft.com/en-us/library/cc817128.aspx
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3.8 Additional OCR language packages  
 

There are multiple OCR language packages built-in to Nitro PDF Pro: Brazilian, Danish, Dutch, English, Finnish, 
French, German, Italian, Norwegian, Portuguese, Spanish, and Swedish. These OCR languages are available in 
each build of Nitro PDF Pro.  

Nitro PDF Pro also allows to extend the OCR language set by installing additional OCR language packages: 

• Simplified Chinese 

• Japanese 

• Russian 

• Ukrainian.  

Each additional OCR language package should be installed on top of the existing Nitro PDF Pro installation. 
They are version specific. To install: 

1. Download the OCR installer that corresponds with the Nitro PDF Pro version: 
o Business Installers: https://www.gonitro.com/installers/business/v13/msi/download  
o Enterprise Installers: https://www.gonitro.com/installers/enterprise/v13/msi/download 

Since OCR language packages are version specific, it is recommended that when upgrading Nitro PDF 
Pro, the corresponding OCR packages are upgraded to the same version as well.   

2. From File Explorer, right-click on the downloaded OCR installer file (.exe) and choose “Run as 
Administrator”. 

After installing, the user can select the OCR language recognition by going to File > Preferences > OCR > select 
the installed language from the dropdown under “Languages”. 

 

  

 

https://www.gonitro.com/installers/business/v13/msi/download
https://www.gonitro.com/installers/enterprise/v13/msi/download
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4 Customizing MSI Properties 
 

Many properties of the MSI deployment package can be customized by using a command prompt, or by 
creating an MST file to be used by the installation process. The table below is a partial list of 
customizable properties, followed by specific examples using the available methods of customization. If 
you require additional customization, please contact Nitro Support. 

 

NOTE: The Deployment Utility is the most convenient and recommended method of adjusting MSI 
properties. A command prompt can be used to adjust many, but not all, of these settings and is commonly 
used if only one or two simple settings need to be changed. 

 
ORCA can be used to make very extensive changes to the installation process, but not all the possible 
options are documented in this guide. It is highly recommended that only experienced admins use this tool. 

 

4.1 Customizable MSI properties 
 
 

NPSERIAL Enter your Enterprise or Business license 
number.  Not required for NLS licenses 

PROXYSERVER Business and NLS licenses require Internet 
access to 
activate Nitro PDF Pro. If you are using a 
proxy server, please specify the required 
information in the format 'server:port' 
(example: 169.0.0.11:8080) 

PROXYUSER Username for Internet access via a proxy 
server 

PROXYPASS Password for Internet access via proxy server 
DT_SHORTCUT Create a desktop shortcut for Nitro PDF Pro 

(Yes=1/No=0) 
OFFICEADDINS Install Nitro PDF Pro add-ins for MS Office 

(Yes=1/No=0) 

NP_PDF Default PDF file association (e.g. 
NitroPDF.Document.10, AcroExch.Document) 

NP_FDF Default FDF file association (e.g. 
NitroPDF.FDFDoc.10, AcroExch.FDFDoc) 

MAXCPUCOREUTILIZATION Maximum number of CPU cores to be used by 
Nitro PDF Pro 

0 = automatically allocate number of cores to 
be used (default) 
1 = 1 core (recommended for Citrix and 
Terminal Server deployments) 
2 = 2 cores 
3 = 3 cores 
4 = 4 cores 

CLOUDENABLE Enable Nitro PDF Pro to connect to Nitro Sign 
(adds relevant buttons to the UI) 

Properties Description 
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DROPBOXDISABLED Configure connection to Dropbox storage 
from within Nitro PDF Pro 
(Disabled=1/Enabled=0) 

ONEDRIVEDISABLED Configure connection to OneDrive storage 
from within Nitro PDF Pro 
(Disabled=1/Enabled=0) 

GOOGLEDRIVEDISABLED Configure connection to Google Drive storage 
from within Nitro PDF Pro 
(Disabled=1/Enabled=0) 

NPBROWSERPLUGIN Install Nitro PDF Pro Internet browser add-in 
(Yes=1/No=0) 

 
 

4.2 Command Prompt Installations 
 

Msiexec.exe is a Windows program that interprets and installs application packages. It can be used via 
the command prompt (CMD) or a script. More information and a full list of options are available at 
https://msdn.microsoft.com/en-us/library/windows/desktop/aa367988(v=vs.85).aspx. The utility can be 
used to simply install Nitro PDF Pro, but also to customize many of the parameters documented in this 
chapter. 

The basic syntax of the command to install an application is: 
 

msiexec /i InstallationFile /<options> Property=Value 

 
 

Example: Use command line installation to customize the “OFFICEADDINS” property 
 

msiexec /i C:\users\JDoe\Downloads\nitro_pro_x64.msi /qn+ OFFICEADDINS=0 

 

This installs Nitro PDF Pro from the Downloads folder of the user JDoe 
• The option “/qn+” suppresses all user interface messages, with the exception of a 

confirmation pop-up at the end (this option requires running the command prompt as 
an administrator) 

• The property “OFFICEADDONS=0” installs Nitro PDF Pro without its MS Office add-ons: 

The only UI seen during the installation process is: 

 
 

https://msdn.microsoft.com/en-us/library/windows/desktop/aa367988(v%3Dvs.85).aspx
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Alternatively, a Transform File (.mst) can be created using the methods described in the following 
sections. This file can contain various properties that will be used by the installation process when using 
the following command: 

 

msiexec /i C:\users\JDoe\Downloads\nitro_pro_x64.msi 

TRANSFORMS=C:\users\JDoe\Downloads\myMSTfile.mst 

 

 

 

 

4.3 Deployment Utility 
 

The Deployment Utility is a visual configuration tool that makes it easy to create an MST file that applies 
your custom configurations to your Nitro PDF Pro deployment. It provides one of the methods for 
customizing MSI properties. 

 

The following screenshots show the default settings used by the Nitro PDF Pro installation, and the 
tables explain the customizations possible using the Deployment Utility. 

 
NOTE: Nitro recommends any setting checked by default to be left as-is, unless otherwise noted. The Nitro 
Sign feature is not checked by default via the Deployment Utility.  Ensure it is checked if you desire to use 
that functionality. 

 
4.3.1 “General” settings 
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Setting MSI Property Description  
Create 
desktop 
shortcut 

DT_SHORTCUT Leaving this box checked will 
result in a Nitro PDF Pro 
desktop 
icon/shortcut being added to 
the users' desktops. 

 

Install toolbars 
for Microsoft 
Word, Excel, 
PowerPoint 

OFFICEADDINS Leaving this box checked will 
install the Nitro PDF Pro plugin 
directly to the Office 
toolbar/ribbon, allowing PDFs 
to be easily created/converted 
directly from the MS Office 
applications Word, Excel, 
PowerPoint, and Outlook. 

 

Uninstall Nitro PDF 
Pro 
v10 and 
earlier (v11 
will be 
uninstalled 
automatically) 

NITRO10_UNINSTALL Checking this box will 
uninstall previous major 
versions (e.g. Nitro PDF Pro 
10.x.x) when installing Nitro 
PDF Pro 13. Nitro PDF Pro 
11.x.x and 12.x.x will be 
uninstalled regardless of 
this setting. 

 

Install printer 

driver 
INSTALL_PRINTER_DRIVER Leaving this box checked will 

install the Nitro PDF Creator. 
Installation without the printer 
driver is required for App-V 
deployments. For all other 
deployments, unchecking this 
setting will prevent users from 
being 
able to create PDF files. 

 

 

Enable Nitro 
Sign features 
like 
e-signatures 
and document 
collaboration 

CLOUDENABLE Checking this box will enable 
Nitro Sign to be accessed 
directly from Nitro PDF Pro. 
Leaving this box unchecked 
will suppress all direct links to 
Nitro Sign and its functionality. 

 

Enable 
crash 
reporting 

(Registry) 
kBugsplatEnableCrashReporti
ng 

Leaving this box checked will 
provide users with the option 
to submit a Bugsplat crash 
report should Nitro PDF Pro 
terminate after encountering 
an issue. The Crash Reporter 
will send a detailed report 
that will help Nitro's 
engineers to diagnose the 
issue. 

 



Nitro PDF Pro Advanced Installation Guide  

20 

 

 

Enable 
integration with 
Dropbox 

DROPBOXDISABLED Leaving this box checked will 
enable users to access PDF 
documents directly from 
Dropbox. 

 

Enable 
integration with 
Box 

BOXDISABLED Leaving this box checked will 
enable users to access PDF 
documents directly from Box. 

 

Enable 
integration with 
OneDrive 

ONEDRIVEDISABLED Leaving this box checked will 
enable users to access PDF 
documents directly from 
OneDrive accounts. 

 

Enable 
integration with 
SharePoint 365 

SHAREPOINT365DISABLED Leaving this box checked will 
enable users to access PDF 
documents directly from 
SharePoint 365. 

 

Enable 
integration with 
network disk 

(Registry) 
network_disk_enabled 

Checking this box will enable 
Nitro PDF Pro to use a local 
copy of a file instead of writing 
changes directly to remote 
storage, until the document is 
saved or closed in Pro. This 
provides a reduction in 
network traffic on over 
utilized networks and should 
ONLY be used in an 
environment with extremely 
unreliable or a slow network 
(i.e.: sub-Mbit connection).  
 

 

 

 

 

4.3.2 “Default Applications & Add-Ons” settings
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Setting MSI Property Description  
Default PDF 
Viewer (Windows 
7 only) 

NP_PDF, NP_FDF Set the default PDF 
application by selecting it 
from the dropdown. 

 
NOTE: Due to a change in the 
behaviour of Windows 8 and 
later, this is not possible for 
those operating systems. The 
default application must be 
set manually after installation, 
or automatically following one 
of the methods described in 
Chapter 7. 

 

Display message if 
not the default 
PDF viewer 

(Registry) 
kPrefGeneralMsgIfNotDefaultPDFViewer 

If this box is checked, users 
will receive a notification that 
Nitro PDF Pro is not the 
default PDF viewer. 

 

Install Nitro PDF 
Pro SharePoint 
and PDF Viewer IE 
add- ons 

NPBROWSERPLUGIN Checking this box will install 
the Nitro PDF Pro Internet 
browser add-ons. The 
SharePoint IE add-on will 
allow opening files from 
SharePoint. 
The PDFViewer add-on will 
enable viewing of 
PDFs in the web browser. 
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Set Nitro PDF 
Viewer IE add-on 
as default 

SET_DEFAULT_MIME_GUID PDF documents opened in 
Internet Explorer will use 
the Nitro PDF Pro add-on. 

 

Set Adobe 
Acrobat PDF 
Viewer IE add- 
on as default 

SET_DEFAULT_MIME_GUID PDF documents opened in 
Internet Explorer will use the 
Adobe Acrobat add-on. 

 
NOTE: Checking this box 
will not install or enable 
the Adobe Acrobat IE add-
on. If the Adobe Acrobat 
add-on is not already 
installed or enabled at the 
time Nitro PDF Pro is 
installed, it will need to be 
installed separately. 

 

Allow opening PDF 
documents from 
Nitro PDF Pro IE 
add- on in 
Adobe PDF 
viewer 

IE_ALLOW_ADOBE_BUTTON Checking this box will allow 
PDF documents opened in IE 
with Nitro PDF Pro to be 
opened in Adobe Acrobat in 
a single 
click. 

 

 

 

4.3.3 “Serial Number” settings 
NOTE: Serial Number settings are not needed or available when customising the NLS edition of Nitro PDF 
Pro. 

 

 
 

 

 
Setting MSI Property Description  
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Load From File / 
Textbox 

NPSERIAL Click “Load from File” to upload your 
Nitro PDF Pro license file (.lic) if you 
are using an Enterprise license; paste 
your license code into the text field if 
you 
are using a Business license 

 

Proxy… PROXYSERVER, 
PROXYUSER, PROXYPASS 

Business licenses require Internet 
access to activate Nitro PDF Pro. If you 
are using a proxy server, please specify 
the required information in the format 
'server:port' (example: 
169.0.0.11:8080), as well as the 
required username and password 

 

Encrypt NPSERIALENCRYPTED By default, Nitro PDF Pro encrypts the 
license code. Certain deployments 
require this setting to be disabled (see 
Chapter 3) 
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4.3.4 “Print” settings 

 

 
 
 

Setting MSI Property Description  

Default Settings  In most cases, we recommend 

selecting “Default” from the 
dropdown.  

Optimize for PCL 
driver 

(Registry) 
PrintBandSize, 
PrintBandCountForIgnore 

If you experience issues when 
printing large image/graphic files to 
specific printers (typically Xerox 
brand PCL pull print drivers), 
selecting “Optimize for PCL Driver” is 
expected to resolve these specific 
printing issues. This setting can also 
be changed post-deployment for 
individual users via the registry key 
settings. 
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4.3.5 “iManage Work 10” settings 
 

Please refer to section 6.8 for full configuration settings for iManage.  
 

 
 

Setting MSI Property Description  

Enable integration 
with iManage Work 
10  

 Checking this box will enable users to 
access documents stored in iManage 
Work 10  

 

iManage install 
path  

 The path must be set to Work 
subfolder where Nitro PDF Pro can find 
iManage dlls. If iManage Install Path is 
missing, Nitro PDF Pro integration with 
iManage will not work and this may 
lead to the situation when the 
documents opened from web-client 
will remain checked out until manual 
check in. 
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4.4 ORCA 
 

Orca is an MSI database editor provided as part of the Microsoft Windows SDK. For more information visit: 
https://msdn.microsoft.com/en-us/library/aa370557(v=vs.85).aspx 
https://msdn.microsoft.com/en-us/library/aa370834(v=vs.85).aspx 

Orca enables you to create a Transform File (.mst) that can be used to customize an installation via a 
command line or with Group Policy Objects/Active Directory software deployment methods. 
NOTE: ORCA can be used to make very extensive changes to the installation process, but not all of the 
possible options are documented in this guide. It is highly recommended that only experienced admins use 
this tool. 

 
Example: Create an MST file that includes the license, does not install the Nitro PDF Pro Internet Explorer 
add-in, and enables the integration with Nitro Sign for eSignature and document collaboration. 

1) Install Orca from the link above and start the program 

2) Click on File > Open, and browse to the location of the Nitro PDF Pro installation MSI 

3) Click Transform, and then click New Transform 

4) Scroll down the left column and select the Property table. 

5) Find NPSERIAL in the right column, and double click on the entry DEMO to edit. Replace this with 
your license number. 

6) Find NPBROWSERPLUGIN and change the value to 0 

7) Find CLOUDENABLE and change the value to 1

8) Your changes will be highlighted in green 

https://msdn.microsoft.com/en-us/library/aa370557(v%3Dvs.85).aspx
https://msdn.microsoft.com/en-us/library/aa370834(v%3Dvs.85).aspx
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9) Click on Transform > Generate Transform to save the .mst file. 

 

5 Updating Nitro PDF Pro 
 

5.1 Minor / Major release 
 

The MSI installer does not automatically check for updates, because in many environments the end user 
will not have permission to install software updates. For users who are deploying with the default 
preferences, no additional steps need to be taken. Nitro PDF Pro can simply be delivered as an update 
via your chosen deployment tool. 

If you have custom preferences embedded in a .cab file however, you will need to recreate the 
transform file first, then update using your chosen deployment tools. 

To obtain the latest installation files, please contact your Nitro Customer Support Representative. 

 
5.2 Preserving configuration settings 

When upgrading Nitro PDF Pro to a major release, such as Nitro PDF Pro 12 to Nitro PDF Pro 13, some settings 
will be migrated silently. 
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Data that will automatically be migrated: 
 

QuickSign Profiles 

Custom Stamps 

Digital IDs 

Digital Signatures 

Certificates 

Security Profiles 

Scanner Profiles 

 
 

6 Special configurations 
 
 

6.1 Setting a default PDF application using an Active Directory GPO 
 

Microsoft has made significant changes to the way applications are able to set themselves as default 
applications for certain file types. Microsoft strongly recommends that application defaults are changed 
by users only, which is the only supported method. As such, applications can no longer be set as default 
during the installation process, and the only supported method for central control is to use the steps 
described below. 

Summary of Steps 

1) Create or obtain an XML file containing the desired default application associations, then 
distribute the XML file to all client machines targeted by the policy 

2) Create a new, or edit an existing GPO to apply the XML file to client computers 
 

Screencast 
A recording of the process can be viewed here for demonstration / clarification purposes: 
https://cdn.gonitro.com/product/se/gpo-demo.mp4 

  

https://cdn.gonitro.com/product/se/gpo-demo.mp4
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Step 1: Create and Distribute the Associations XML File 
 

The default application associations can be exported in XML form. The resulting XML file will contain all 
default application associations of the client machine, for example: 

 
 

The file can be edited to include only the relevant file types / applications. 

 
 

Alternatively, download and use the files linked below to set Nitro PDF Pro 12 or Nitro PDF Pro 11 as the 
default application for PDF, FDF, XFDF, and PPDF files: 

 

Nitro PDF Pro 13: https://cdn.gonitro.com/product/se/app-assoc-nitro-13.xml  
Nitro PDF Pro 12: https://cdn.gonitro.com/product/se/app-assoc-nitro-12.xml  

 

  

https://cdn.gonitro.com/product/se/app-assoc-nitro-13.xml
https://cdn.gonitro.com/product/se/app-assoc-nitro-12.xml
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Steps-by-step guide: 
 

Step Action 

1. On a computer that has Nitro PDF Pro 12  installed and configured as the default application for the 

relevant file types, open an elevated command prompt. 

 

 
 

2. Execute the following command: 
Dism.exe /online /export-defaultappassociations:<path and filename> 

 

Example: 

Dism.exe /online /export-defaultappassociations:C:\AppAssocations.xml 
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Step Action 

3. Open the XML file in a text editor e.g. Notepad and remove all “<Association Identifier=…” 

entries not referring to Nitro PDF Pro. 

Do not remove any other lines. The resulting file should look like this: 
 

 
 

4. This XML file needs to be accessible from all client machines that require the settings to be 
changed. The easiest and most reliable option would be to copy the file to the same location on 
all clients, e.g. C:\AppAssociations.xml 

 

 
 

5. The file could also reside on a mapped network drive that all clients have access to, e.g. 
P:\AppAssociations.xml. In this case, ensure that: 

- All clients use the same drive letter for this location 

- The drive is mapped before the policy setting is applied 
 

If the policy setting is unable to access the file in the specified location, the change of default 
application association will fail without any error messages. 

 
 

Step 2: Apply the GPO Setting 
 

The GPO setting described in the steps below will configure a policy to force client computers to use a 
specific file for their application defaults. The policy setting only contains the path to the file, which 
needs to be made available to all applicable client machines. 
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Step-by-step guide: 
 

Step Action 

1. Open the Group Policy Management console, create a new policy or select an existing one. 
Right click and go to “Edit”. 

 
 

2. Find the setting “Set a default associations configuration file” in 
Computer Configuration > Administrative Templates > Windows Components > File Explorer. 
Double-click on it to open the configuration window. 
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Step Action 

3. Set the policy to “Enabled” and specify a valid path to the XML file created in step 1 - “valid” 
meaning it is accessible from all client machines this policy applies to, at the time the policy is 
applied! 

Example: In the screenshot the configuration file option is set as C:\AppAssociations.xml 

 
This means that for the policy to apply successfully, any relevant client machine MUST have a 
copy of the AppAssociations.xml file in the root of its respective C drive! 

 

 
 

4. Click ok to confirm the configuration change, then close the policy editor window. 

 

NOTE: The path in the “Options” section of the policy is relative, i.e. if you configure the location of the file 
to be used as “C:\...” make sure the XML file exists on all client computers in that location. If you use a 
mapped network drive instead, ensure all clients have access to it, and that the mapping occurs before the 
policy applies, or it will fail. 

 
NOTE: The file type association will be applied every time the policy applies. If a user manually changes 
this setting, or another application changes it, it will be reset with the next policy refresh (e.g. reboot). 

 
6.2 Setting Default Applications using PowerShell Script 

A PowerShell script “set-nitro-defaults” allows to set Nitro PDF Pro as default application for viewing 
PDF files and choose default Internet Explorer add-ons for viewing PDF files in the browser. 

Download the “Set Nitro as Default Application” script from: 

Business Installers: https://www.gonitro.com/installers/business/v13/msi/download 

Enterprise Installers: https://www.gonitro.com/installers/enterprise/v13/msi/download

https://www.gonitro.com/installers/business/v13/msi/download
https://www.gonitro.com/installers/enterprise/v13/msi/download
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By running this script, Nitro PDF Pro will be set as a default application at the local machine level (HKLM) 
for all users. You can also choose to set Nitro PDF Pro or Acrobat Internet Explorer add-on as default, 
which will enable users to view PDF files in the chosen IE add-on. 

 
 

Preconditions 

 

1) Nitro PDF Pro must be installed on user's machines 

2) Adobe Acrobat (Reader or Pro) must be installed on user's machines if setting Acrobat IE add- 
on as default (this condition is not verified as part of the script) 

 
Parameters 

 

The script includes three possible command line parameters, which can be used in different sequence. 
 

Command Line Outcome OS Version 

-set_nitro_ie_plugin Sets Nitro PDF Pro IE add-on as default for 
opening PDFs in browser 

Windows 8.1 and 10 

-setacrobat_ie_plugin Sets Acrobat IE add-on as default Windows 8.1 and 10 

 
Example 1  

 

powershell -noprofile -executionpolicy bypass -file ".\set-nitro- 

defaults.ps1" -set_nitro_default_viewer -set_nitro_ie_plugin 

After script execution, Nitro PDF Pro will be set as a default PDF viewer in system settings 
and Nitro PDF Pro add-on will be set as default Internet Explorer add-on for PDF viewing in Internet 
browser. 

 
Example 2 

 

powershell -noprofile -executionpolicy bypass -file ".\set-nitro- 

defaults.ps1" -set_acrobat_ie_plugin 

 
After script execution Acrobat add-on will be set as default Internet Explorer add-on for PDF viewing in 
Internet browser. 

 

Example 3 
 

powershell -noprofile -executionpolicy bypass -file ".\set-nitro- 

defaults.ps1" -set_nitro_default_viewer -set_acrobat_ie_plugin 

 

After script execution Nitro PDF Pro will be set as default PDF viewer in system settings 

and Acrobat add-on will be set as default Internet Explorer add-on for PDF viewing in Internet browser. 
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6.3 Setting Default Internet Explorer add-ons 

Nitro PDF Pro Internet Explorer add-ons 

Nitro PDF Pro offers two add-ons for Internet Explorer: 

• PDF Viewer add-on for opening files within the IE browser 

• PDF Viewer add-on for opening files from SharePoint 2016 locations 

Both add-ons are installed simultaneously; Nitro PDF Pro does not offer a way to install them separately. 
The IE add-ons are compatible with Internet Explorer v11. 

Internet Explorer does not offer a method in its user interface to change the default IE add-on setting, 
only to enable/disable individual add-ons. If one is set to be the default and is disabled, IE will not 
automatically use the other one, but typically fail to open PDFs at all. 

 

Note: 

Nitro PDF Pro SharePoint add-on can work alongside other non-SharePoint PDF add-ons. Internet 
Explorer will not automatically use other add-ons to open documents. For example, a user can have a 
non- SharePoint Acrobat add-on set as default and also use Nitro PDF Pro SharePoint add-on for 
opening files from within SharePoint. 

 

Setting Nitro PDF Pro IE add-ons as default 

If a user has multiple PDF Viewer add-ons installed for Internet Explorer (e.g. the Nitro IE add-on and 
also the Acrobat add-on), one of them will be set as the default and used by IE to open PDF files. 

Typically, the default is the last one installed for the generic IE add-on. 

There are several ways to set Nitro PDF Pro IE add-on as default: 

1. Via Deployment Utility, when deploying Nitro PDF Pro (deployment teams) (Section 4.3) 

2. By running a PowerShell script (deployment teams) (Section 6.3) 

3. By changing a registry key (below) 
4. By changing IE defaults in Nitro PDF Pro preferences (individually) (refer to user 

guide)  

Note 

When Adobe Updater is run: 

• Adobe Acrobat will become a default IE add-on for viewing PDF files 

• Nitro PDF Pro SharePoint IE add-on will always remain a default, even after Adobe Updates 

Recommendations 

Setting and keeping Nitro PDF Pro IE add-ons as default 

It is recommended to set Nitro PDF Pro IE add-on as default, which will open documents in Nitro PDF 
Pro IE add- on by default, unless customers must work with XFA documents. 

If you have Adobe Acrobat in your organization and run updates regularly, each time an update is run, 
Adobe will become a default IE add-on. In such case, it is recommended to: 

• Run a PowerShell script right after Adobe update, to ensure Nitro PDF Pro remains a default on 
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users’ machines. 

• Users can change the default individually by changing the registry key 

• Users can change the default in Nitro PDF Pro Preferences 

XFA documents & setting Adobe Acrobat IE add-on as default 

When users must work with XFA documents (XML Forms Architecture) majority of the time, it is 
recommended to set Adobe Acrobat IE add-on as default. Nitro PDF Pro does not fully support XFA 
documents and users may be unable to work with dynamic XFA documents within Nitro PDF Pro. 

Note 

If users must work with XFA documents occasionally, it is recommended to set Nitro PDF Pro IE add-on 
as default but enable opening PDF documents in Adobe Acrobat from Nitro PDF Pro IE add-on. In such 
cases, users will have Nitro PDF Pro IE add-on as default, but will have an ability to open some files, 
such as XFA in Adobe Acrobat. (Section 4.3 Default Applications and Add-ons). 

 

 
6.4 Changing Internet Explorer Defaults via Registry Key 

It is possible to set the default by editing the following registry key: 

HKEY_CURRENT_USER\Software\Classes\MIME\Database\Content Type\application/pdf 

 

 
 

 

Set the value for “CLSID” to one of the following values: 

1) Use the Nitro IE add-on as default: 

{3A7B4EA1-8CA8-4629-B09A-FB4EE0632BA8} 

2) Use the Adobe add-on as default: 

{CA8A9780-280D-11CF-A24D-444553540000} 
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Using a Group Policy to deploy a registry setting 

 
1) Create a new Active Directory GPO or edit an existing one 

2) Go to the Settings tab. Right-click on User Configuration and select Edit 

3) Expand Preferences > Windows Settings, right-click on “Registry” and select New > Registry 

Item 
 

 
 

 

4) Select the action “Update”, then set the following options: 
Hive: HKEY_CURRENT_USER 
Key Path: Software\Classes\MIME\Database\Content Type\application/pdf 
Value name: CLSID 
Value type: REG_SZ 

5) Enter the following information in the “Value data” field, according to your preference: 
Nitro IE add-on as default: {3A7B4EA1-8CA8-4629-B09A-FB4EE0632BA8} 

Adobe add-on as default: {CA8A9780-280D-11CF-A24D-444553540000} 

 

6.5 Preventing Nitro PDF Pro Outlook add-ins from being disabled 
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Programs in Office 2013 and later versions provide add-in resiliency, meaning that apps will disable an 
add-in if it performs slowly for any reason. Add-ins can be enabled and/or protected from being auto- 
disabled by editing registry settings accordingly. 

 

See also: https://msdn.microsoft.com/en-us/vba/outlook-vba/articles/support-for-keeping-add-ins- 
enabled 

 
 

Ensure Nitro PDF Pro add-ins are loaded at startup 

To ensure the Nitro PDF Pro add-in always loads at startup, you can alter the “Load Behavior” registry keys 

located under: 

(64-bit Office HKCU) HKEY_CURRENT_USER\Software\Microsoft\Office\Outlook\Addins\NitroPDFPro 
fessional.MSOfficeAddinXX 

(64-bit Office HKLM) 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Office\Word\Addins\N 
itroPDFProfessional.MSOfficeAddinXX 

 
NOTE: Replace “XX” in the registry keys above with your version of Nitro PDF Pro, e.g. “12”. Nitro 
recommends setting the value to 3 to load them at startup. 

 

 

 

3 - Loaded - Load at startup 
The application tries to load the VSTO Add-in when the application starts. This is the default value when 
you build or publish a VSTO Add-in in Visual Studio. If the application successfully loads the VSTO Add-in, 

the LoadBehavior value remains 3. If an error occurs when loading the VSTO Add-in, the LoadBehavior 
value changes to 2, and remains at 2 after the application closes. 

 
  

https://msdn.microsoft.com/en-us/vba/outlook-vba/articles/support-for-keeping-add-ins-enabled
https://msdn.microsoft.com/en-us/vba/outlook-vba/articles/support-for-keeping-add-ins-enabled
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Prevent Nitro PDF Pro add-ins from being disabled automatically 
 

To ensure that the Add-in never becomes disabled, Nitro recommends adding the 
ClassID NitroPDFProfessional.MSOfficeAddinXX to the ‘DoNotDisableAddinList’: 
NOTE: Replace “XX” in the value above with your version of Nitro PDF Pro, e.g. “13”. 

 

HKEY_CURRENT_USER\Software\Microsoft\Office\16.0\Outlook\Resiliency\Do NotDisableAddinList 

 
 

 
NOTE: The above registry keys can be deployed via Active Directory GPO. Please see Chapter 6.2 for an 
overview of this method. 

 
 

6.6 Rights Management Services (RMS) and Azure Information Protection (AIP) 
 

RMS is older integration that will be deprecated by Microsoft in September 2020.  
To access PDF files that have been protected using Microsoft’s Rights Management technology, the 
machines accessing the protected files will need to install Microsoft’s Active Directory Rights 
ManagementService(ADRMS)Client2.1 and MicrosoftOnlineServicesSign-InAssistant. Nitro PDF Pro will 
then be able to decrypt RMS protected PDF files and grant RMS defined permissions to users. 
 
Azure Information Protection is successor to RMS. To enable Azure Information Protection- check the 
box in the Deployment Tool.  It is also suggested to contact Nitro Support for additional assistance in 
enabling AIP. 
 
We do not recommend using both integrations at the same time.  

 
 

6.7 iManage Work 10  
 
6.7.1 iManage Work 10 integration deployment  

 
Step 1: Add Nitro PDF Pro to the allowed apps on the iManage server 
NOTE: if you have more than one iManage server, this step must be done on EACH iManage server. 

In iManage Control Center (IMCC) add Nitro PDF Pro to the allowed applications: 

• if you use an account on cloudimanage.com: select and add Nitro PDF Pro from Application List 

• if you use other iManage 10.2+ server (cloud or on-premises): add Nitro PDF Pro manually with 

predefined Client ID: 

       Client ID / API Key 0127f653-a333-483f-b6b4-fb452b5959a7 
       Client Secret / API Secret <autogenerated> 

Redirect URL http://localhost/ 

http://www.microsoft.com/en-us/download/details.aspx?id=38396
http://www.microsoft.com/en-us/download/details.aspx?id=38396
http://www.microsoft.com/en-us/download/details.aspx?id=28177
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       Application Type Native 
Step 2: Register Nitro PDF Pro as an integrated application 
NOTE: if you have more than one iManage server, this step must be done on EACH iManage server. 

1. Download imWorkOptions.xml file from IMCC. If there is no such file, the template can be downloaded 

from iManage Help Center or created manually. 

2. In imWorkOptions.xml, add the section that marks Nitro PDF Pro as integrated application: 

<ws_options> 
    <ws_option name="integration"> 
        <key name="IntegratedProcesses" value="NitroPDF"/> 
    </ws_option> 
</ws_options> 

IMPORTANT:  

• Ensure that “<ws_options>” does not contain attribute “applyToAll”. If this attribute exists – 
please, remove it; 

• The value of “IntegratedProcesses” has to be exactly “NitroPDF” as it corresponds to the name of 
Nitro PDF Pro process on a client. 

3. Upload the result document back to the IMCC. 

4.  To update the configuration on a client side, it is required to reconnect to the iManage server. 

For more information see iManage Work Desktop for Windows Customization Guide 10.2.4.pdf or newer. 

 
Step 3: Enable refresh token for Nitro PDF Pro on iManage server 
NOTE: if you have more than one iManage server, this step must be done on EACH iManage server. 

1. Download the "iManage: enable refresh token" script from: 

a. Business Installers: 

https://www.gonitro.com/installers/business/v13/msi/download 

b. Enterprise Installers: 

https://www.gonitro.com/installers/enterprise/v13/msi/download 

2. Unpack zip file and follow the instructions from “readme.txt”. 
 
Step 4: Setup client side 
NOTE: if you have more than one iManage server, this step must be done on EACH iManage server. 

On client workstations: 
1. Ensure that iManage Work Desktop for Windows 10.5 or newer (also known as iManage Agent) is running 

and connected to the iManage server. 

2. Before installing Nitro PDF Pro, generate MST file with iManage integration enabled by Nitro PDF Pro 

Deployment Tool: 

https://help.imanage.com/hc/en-us/article_attachments/360050184193/iManage_Work_Desktop_for_Windows_Customization_Guide_10.2.4.pdf
https://www.gonitro.com/installers/business/v13/msi/download
https://www.gonitro.com/installers/enterprise/v13/msi/download
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IMPORTANT: The path must be set to Work subfolder where Nitro PDF Pro can find iManage dlls. If iManage 
Install Path is missing, Nitro PDF Pro integration with iManage will not work and this may lead to the 
situation when the documents opened from web-client will remain checked out until manual check in. 

 
1. Install Nitro PDF Pro with a created MST file. For more details see section 6.7.2 “How to enable iManage 

integration with Deployment Tool”. 

2. Set Nitro PDF Pro as a default PDF viewer 

 
6.7.2 How to enable iManage integration with Deployment Tool 

 
Step 1: Preconditions 
1. Uninstall the previous version of Nitro PDF Pro 

2. Download Nitro PDF Pro installer and related to it Deployment Tool. NOTE: it is important to have 

Deployment Tool of the same version as the Nitro PDF Pro installer. 

Step 2: Prepare MST file with enabled iManage integration 
1. Start Deployment Tool 
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2. In the top right corner, click on a Browse... button and select the downloaded Nitro PDF Pro installer (MSI 

file). For example: 

 

 

 

3. On the lest panel, select “iManage Work 10” section. 

4. Select check box “Enable integration with iManage Work 10”. 
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5. In the edit field "iManage Install Path” set path to the Work subfolder under the iManage installation 

folder. NOTE: this subfolder must contain the iManage DLLs. For example: 

 

 
 

6. At the bottom of the dialog, check the agreement check box and click “Generate MST File”. For example: 

 

 

 
7. When MST is generated successfully the message will appear with the path to the MST file. 

8. [IMPORTANT] Close the deployment tool dialog. 
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6.8 SharePoint Online extension 

The SharePoint Online extension is a SharePoint Framework-based application that allows users to 
open a SharePoint Online document in Nitro PDF Pro desktop application from within the web 
browser.  

With the Nitro PDF Pro extension for SharePoint Online, users no longer need to download, edit, and 
upload their documents manually when they want to work with SharePoint Online. This three-step 
workflow can now be done in just a couple of clicks.  

 

6.8.1 SharePoint Online extension deployment 
 

Step 1: Preconditions 
1. To deploy the SharePoint Online extension the SharePoint admin permission is required 

2. The extension works with the sites with Modern View 

Step 2: Download the SharePoint Online extension from: 

Business Installers: https://www.gonitro.com/installers/business/v13/msi/download 

Enterprise Installers: https://www.gonitro.com/installers/enterprise/v13/msi/download 
 

NLS Installers: https://www.gonitro.com/installers/nls/v13/msi/download 

 

NOTE: the extension is not available on Microsoft Marketplace as each package requires to work 
with a compatible Nitro PDF Pro version. 

 
Step 3: Ensure that the downloaded version is compatible with the installed version of Nitro PDF Pro.  
In order for the Nitro PDF Pro SharePoint Online extension to work properly, it is recommended to have a Nitro 
PDF Pro version that corresponds to the deployed package version installed:  
 

SharePoint Online extension  Nitro PDF Pro  

1.0.0.8  13.45 

1.2.0.x 13.46 - 13.48 

1.3.0.x  13.49+  
 

Step 4: Follow the instructions from Microsoft: Use the App Catalog to make custom business apps available for 
your SharePoint environment. Note:  SharePoint admin permissions may be required. 
 
During the deployment, SharePoint Online gives an option to deploy the package tenant wide or per site. If the 
package is deployed tenant wide it will be automatically available for use on all sites and sub-sites of the current 
SharePoint tenant.  
 

https://www.gonitro.com/installers/business/v13/msi/download
https://www.gonitro.com/installers/enterprise/v13/msi/download
https://www.gonitro.com/installers/nls/v13/msi/download
https://urldefense.proofpoint.com/v2/url?u=https-3A__docs.microsoft.com_en-2Dus_sharepoint_use-2Dapp-2Dcatalog&d=DwMGaQ&c=9_N7KRHYmXm_QBUpFTMhAg&r=ryZja_UZ8NfeZ_nbQZ8NJPxfj2G-Od0r-LIsrb4Ec-4&m=oZBQimUzLFgd4CyBhpREloIjS14dpEzwaF40cNeFZCwQ6JkY4VXBYcIl-FhvLF7s&s=dvsUPD3hWRQ-a-g7fjgtDjUdObLVpCDhnAQl1buWUX4&e=
https://urldefense.proofpoint.com/v2/url?u=https-3A__docs.microsoft.com_en-2Dus_sharepoint_use-2Dapp-2Dcatalog&d=DwMGaQ&c=9_N7KRHYmXm_QBUpFTMhAg&r=ryZja_UZ8NfeZ_nbQZ8NJPxfj2G-Od0r-LIsrb4Ec-4&m=oZBQimUzLFgd4CyBhpREloIjS14dpEzwaF40cNeFZCwQ6JkY4VXBYcIl-FhvLF7s&s=dvsUPD3hWRQ-a-g7fjgtDjUdObLVpCDhnAQl1buWUX4&e=
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Otherwise, after deployment, the package should be enabled manually on each site where it should be used. 
For this: 

1. Open SharePoint site settings → Add an app. 
2. From a menu on the left select “From my organization” 
3. Search for “Nitro PDF Pro for SharePoint Online” application and click Add 
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If the SharePoint extension is deployed correctly, the “Open in Nitro PDF Pro” option will appear on the 
command bar and in the document context menu on a site:  
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6.8.2 Consent 
The first time a user opens a document using the SharePoint Online extension, they may be requested to accept 
consent. It is recommended to log in to SharePoint Online from Nitro PDF Pro with admin permissions first and 
accept the consent on behalf of the organization.  
 
The full list of the permissions that Nitro PDF Pro may request is:  
 

Permissions  Type Description Needed for feature Notes 

Microsoft Graph 

User.Read Delegated Sign in and read user 
profile  

- SharePoint Online 
- OneDrive  
- Azure Information 

Protection 

Allows sign in, 
called "generally 
required" in MS 
docs. 

Files.ReadWrite   Delegated Have full access to user 
files   

- OneDrive 
- SharePoint Online  

 
 

 

Sites.Manage.All   Delegated Create, edit, and 
delete items and list in 
site collections 

- SharePoint Online 
 

Needed to upload 
files to 
SharePoint.  

Offline_access   Delegated Maintain access to 
data you have given it 
access to  

- OneDrive 
- SharePoint Online  

Give access to 
refresh tokens, 
called "generally 
required" in MS 
docs.   

Azure Rights Management Service 

user_impersonation   
 
 

Delegated Create and access 
protected content for 
user   

- Azure Information 
Protection 

Requested by MIP 
SDK when reading 
policy and labels.   

Microsoft Information Protection Sync Services 

UnifiedPolicy.User.Read Delegated Read all unified policies 
a user has access to  

- Azure Information 
Protection 

Requested by MIP 
SDK when reading 
policy and labels 

 
6.8.3 Explaining OAUTH Access Token management   

The access token is stored in    
C:\Users\<user>\AppData\Roaming\Nitro\Pro\13\ms_graph_token_cache.msal    

and is handled and encrypted using the Microsoft.Identity.Client library.   

To protect ms_graph_token_cache.msal Nitro PDF Pro is using Windows Data Protection API, which encrypts 
data with the current user’s credentials.  

The only access information that Nitro PDF Pro handles is the login e-mail, and it stores it directly in the registry 
key:   
HKEY_CURRENT_USER\Software\Nitro\Pro\13\Settings\MicrosoftAccount\email   

Everything else is handled via the AIP SDK (that will end in the MSI and MSIPC folder) or 
the Microsoft.Identity.Client.  
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More information about the Microsoft Identity platform and authentication can be found 
here: https://docs.microsoft.com/en-us/azure/active-directory/develop/v2-oauth2-auth-code-flow.  

 

 

7 Contacting Support 
 

If you experience any issues, please contact our support team through our website: 
http://www.gonitro.com/support 

To ensure a quicker response, please include as much information as possible, including

• Company Name 

• Your Nitro Account Executive 

• Serial number(s) 

• License type(s) 

• Application version 

• Operating System(s) 

• Anti-virus software used 

• Deployment methods 

For Remote Desktop Services/XenApp deployments please also include the following in your support 
request: 

• Server Operating System 

• Application Delivery method (RDS, Streamed, Published App, Published Desktop, etc.) 

• Size of farm 

• Virtualization methods (if any) 

https://docs.microsoft.com/en-us/azure/active-directory/develop/v2-oauth2-auth-code-flow
http://www.gonitro.com/support
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